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ation.

                   

ct control panel 

Program Select buttons
In t

Ste
1

HIN

2

HIN

3

HIN
Quick Start
his section we’ll explain the basics of using JamVOX by taking you through the actual steps of oper

p1 Listen to the sound of the guitar programs
Click the Program Select buttons (q/u) located at the right of the 
Guitar program name.Clicking these buttons will move up or down 
through the programs one by one. Play your guitar to try out each 
program.

T: You can also use other ways to select programs. (☞“Selecting a 
guitar program” on page 8)

Click the Amp/Cabinet name displayed above the Effect routing sec-
tion.
In the Amp/Cabinet combination catalog that appears, you can 
change the amp/cabinet.

T: You can also change the effect units in the same way.

Try dragging and dropping an effect device to the location where you want to connect it.
You are free to change the connected order of all of the effect units.

T: The amp/cabinet and effect units can be adjusted in their corresponding control panel. The Effe
is shown for the effect device you select by clicking.

Effect
 routing

Guitar
 program

 name

Amp/Cabinet
 control panel

Effect Ctontrol
 panel
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.aif/.aiff), 

 

MP3

 

 (.mp3), 

 

Windows Media 

   

. Song data protected by DRM (Digital Rights 
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GXT edit panel
tep2 Play back a song and cancel the guitar part

Add song data from your computer to the library by dragging and dropping it into the Main list.

The following formats of song data can be added to the library and played: WAV (.wav/.wave), AIFF (
Audio (.wma, supported only in Windows), and AAC (m4a, supported only if QuickTime 7 is installed)
Management) cannot be played.

Double-click the name of a song you added.
The song will play.

INT: To adjust the volume, use the fader located in the right side of the Mixer.

Drag the Progress bar pointer to find the guitar solo within the song, and play it back.

Click the GXT button.
The guitar solo will be removed from the playback.

INT: The effectiveness of the cancellation will depend on how the guitar solo is mixed. In the GXT edit 
panel, try adjusting the cancellation effect by dragging the pointer and the gray area.

INT: You can use the Extract button of the GXT edit panel to isolate and emphasize the guitar solo in the 
playback. Using this in conjunction with the Tempo change function (which lets you slow down the 
playback speed without affecting the pitch) can be helpful when you’re practicing.

Mixer GXT button

Main listSource list

Record button Progress bar
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DNESS knob to adjust the high/low boost. Use 

er the fader.

  

you can match the song to the tuning of your gui-
 a song that is detuned.

ing of guitar programs, and downloading/

    

 iTunes. We will not use these in this example, so 

  

ngs on the CD.

r CD, you’ll need to enter the song title and artist 
r i

    

 the Preferences dialog box.

   

VD drive is an external drive. You'll need to use 
to the JamVOX software.
Step3 Perform along with 
Now you can simply play your guitar alon
To record your performance (along with th

HINT: Use the fader located in the right s
the left fader to adjust the guitar’s 

Depending on the song that’s playin

HINT: By using the Pitch change function
tar. This is also convenient if your 

JamVOX has many other convenient funct
uploading of various programs.
Please read the Owner’s manual to learn h

Importing the guitar karaoke t
Here’s how to import the bundled guitar k

1 Insert the music CD into your comput

Normally, Windows will display a d
simply close the dialog box or iTune

2 From the File menu, choose “Import C
The Import CD dialog box will appear

The song titles and artist names will
name into the JamVOX software afte

3  If there are any tracks you don't want

NOTE: If you want to change the audio fo

4 In the lower right of the dialog box, cli
Wait until importing has been comp

The JamVOX software won’t be able t
other software that is able to import a 
 to imp

rmat i

ck the 
leted.

o impor
CD from
the s
g with
e song

ide of t
volum

g, raisi

 which
guitar i

ions su

ow yo

rack 
araok

er.

ialog b
s.

D...”.
. This d

 be sho
ong
 the song!
), just click the Record button.

he Mixer to adjust the volume of the song, and the LOU
e, and the PAN knob to adjust its stereo position.

ng the LOUDNESS knob may cause distortion. If so, low

 changes the pitch without affecting the playback speed, 
s tuned in regular tuning and you’re playing along with

ch as Loop or Chain playback of songs, automatic chang

u can take full advantage of JamVOX’s potential!

CD
e track CD into the JamVOX software.

ox asking you to choose an action, and Mac will start up

ialog box will show the titles and artist names for the so

wn only for this bundled CD. If you’re importing anothe
mporting.

ort, click them to clear their check boxes.

n which the tracks will be imported, change the setting in

“Import” button.

t the CD if you’re using a Windows computer whose CD/D
 an external drive, and then add the resulting audio files in
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 follows.

           

factory

   

iders

 

r

 

t its value to the location at which you clicked.

 

r up/down or left/right

 

just its value.

  

sor on a knob or fader and use the mouse wheel to 

 

r up/down or left/right while holding down your 
computer’s [Shift] key

 

e adjustments to the value.

  

and enter a numerical value from your computer 

  

eset the fader or slider to its default setting.
You

Kn

Dra
Dra
on 
Op

Mo
You
adju

Dra
Thi

Do
Dou
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Use
Clic
cur
adju
Wh
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righ
the
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uble-
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TE:
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k the

sor k
stm

en th
 use 
t of 

 knob
r computer’s keyboard to adjust the value
 knob to select it, and use your computer ’s up/down/left/right 

eys to adjust the value. Use the up/down keys to make coarse 
ents, and the left/right keys to make fine adjustments.
ere is a horizontal row of multiple knobs shown in the panel, you 
your computer’s [Tab] key to move to the knob located at the 
the currently-operated knob. Press [Shift]-[Tab] to move back to 
 located at the left.

This lets you make fin

Click the value
You can click a value 
keyboard.

Double-click
Double-clicking will r
Basic operation
 operate JamVOX’s controllers and parameters using your computer ’s mouse and keyboard as

s

adjust the value of the knob. The method of dragging will depend 
Knob Operation Method” setting in the “Preferences...” of the 

enu. By default, you’ll drag in a straight line to adjust a value.

heel
 place the cursor on a knob or fader and use the mouse wheel to 
e value.

ile holding down your computer’s [Shift] key
 you make fine adjustments to the knob’s value.

click
click to reset a knob to its default setting.

“Default setting” means the value or setting that was set at the 

Faders and sl

Click a fader or slide
Click the control to se

Drag a fader or slide
Drag the control to ad

Mouse wheel
You can place the cur
adjust the value.

Drag a fader or slide
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) buttons

  

r decrease each time you click the button.

  

ously increase or decrease the value.

    

etting from the menu 
Click
Click a switch or button to change the setting each time you click it.
Use your computer’s keyboard to adjust the value
Click the fader or slider to select it, and use your computer ’s up/down/
left/right cursor keys to adjust the value. Use the up/down keys to make 
coarse adjustments, and the left/right keys to make fine adjustments.
When there is a horizontal row of multiple faders or sliders shown in the 
panel, you can use your computer’s [Tab] key to move to the fader/slider 
located at the right of the currently-operated knob. Press [Shift]-[Tab] to 
move back to the fader/slider located at the left.

Drag a fader or slider up/down or left/right while holding down your 
computer’s [Alt] key (Mac: Shift+Option key)
This will adjust the value according to the speed at which you move the 
mouse. As when using [Shift]+drag, fine adjustments can be made using 
only mouse operations. If you want to make large changes to the value, 
move your mouse at the normal speed to set the approximate value. Then 
move the mouse slowly to make fine adjustments.

NOTE: This function is available only for faders and sliders that have a 
wide value of values and a narrow space in which to drag.

Switches and buttons

ππππ/†††† (Inc/Dec

Click
The value will increase o

Press
Press a button to continu

Popup menus
Click ††††
Then select the desired s
that appears.
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Here you can select and adjust the amp model, and select the cabinet 

      

volume of the guitar, mic, and music player 

  

or record songs.

  

e music, guitar programs, and GXT programs.

  

ns for various functions used with the music 

  

t load on your computer.
s 80%, try the following steps.
re running, close them.
“Preferences” - “Hardware,” change the 
ward the “Slow” side. However if this is too 
re of a delay from when you play your guitar 

y produced.
model.

8. Effect control panel
This shows the effect module that’s selected in the effect routing area.
You can edit the parameters of the effect module that’s displayed.

9. METRONOME
Here you can turn the metronome on/off, and specify its tempo and time 
signature.
1. VOX logo
You can click this to view the About screen, which provides information 
about the version.

2. Program select (program name, qqqq/uuuu buttons)
Here you can view and select the program.

3. Utility buttons
This area contains buttons that perform various functions for guitar pro-
grams, such as the Save button, Compare button, and Audition button.

4. Tube (Valve)
This area displays vacuum tubes. The type and number of vacuum tubes 
shown will depend on the amp model you’ve selected. The way in which 
the vacuum tubes illuminate will depend on the “VR GAIN” setting of 
the amp model.

5. PICKUP SELECTOR
This simulates the guitar’s pickup.

6. Effect routing
The effect routing shows the amp model and how the various effect mod-
ules are arranged.

7. Amp/cabinet control panel

10. MIXER
Here you can adjust the 
tracks.

11. Music player
Here you can play back 

12. Library/list
This area lets you manag

13. Function buttons
This area contains butto
player.

14. CPU meter
This indicates the curren
If the percentage exceed
• If other applications a
• In the Options menu 

“Response setting” to
slow, there will be mo
until sound is actuall
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elect a program

  

 click “Guitar programs” to select it.
ed on your computer will be shown in the 

m shown in the main list, double-click its 

ams by using an optional VOX VFS2 foot 
 the JamVOX monitor (☞“Option pedal/
page 32).

Main List
Select
JamVOX 
Here’s ho

Using t
You can u
one.
Click one
name.
The uuuu bu
preceding

Using t
You can u
guitar pro
Click the 
appears.
Performing
ing a guitar program
contains one hundred programs or more.
w to select programs.

he program select buttons to select a program
se the program select buttons to step through programs one by 

 of the program select buttons located at the right of the program 

tton selects the next program, and the qqqq program selects the 
 program.

he popup menu to select a program
se the popup menu to make a selection while browsing a list of 
gram names.

program name, and choose a program from the menu that 

Using the library to s
1 In the “Master Library,”

The guitar programs sav
main list.

2 To select a guitar progra
name.

HINT: You can select progr
switch connected to
switch settings” on 

Master Library
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3 You can audition a displayed program by double-clicking it.

unction to hear a guitar program 
 play your guitar
ses one of the provided audition riff loops (guitar 
sound of the guitar program you’ve selected, so 
m without having to play your guitar.

y buttons located at the right of the program 
Audition button.
 play.

t the right of the Audition button, and choose a 
u that appears.

l stop when you click the Audition button again.
If you haven’t registered as a user, proceed with registration as 
directed by the dialog box that appears.

4 If you like the program, click the download button that’s shown in the 
main list, and the program will be saved in “My Downloads.” 3 The audition riff wil
Downloading guitar programs from JamVOX-Online
You can create your own guitar programs in JamVOX and upload them to 
JamVOX-Online, or download and use guitar programs that were created 
and uploaded by other users.
Here’s how to download guitar programs.

In order to use JamVOX-Online, your computer must be connected 
to the Internet.

You’ll need to register as a user in order to audition or download 
guitar programs. If you haven’t registered as a user, you’ll only be 
able to search.

1 In the library, click JamVOX-Online to select it.
The main list will show popular guitar programs and GXT programs.

2 If the program you want to use is not shown, enter a song title or artist 
name in the SEARCH field and press your computer’s Return key.
The search results are shown in the main list. If you don’t get the 
results you want, try changing the terms you enter in the SEARCH 
field.

NOTE: To quickly find guitar programs suitable for a favorite song, click 
the magnifying glass button  located at the right of the 
“Name” shown in the main list. The “Song title” and “Artist” will 
automatically be entered in the SEARCH field, allowing you to 
quickly find the desired guitar program.

Use the Audition f
without having to
The Audition function u
phrases) to audition the 
you can hear the progra

1 In the group of utilit
select area, click the 
An audition riff will

2 Click the †††† located a
phrase from the men
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P

 

T

 

1

  

2

         

3

 

The display will show the note name that is closest to the pitch you 

 

N

  

4

  

ter of your guitar — 

 

es the characteristics of various guitar pick-
 the pickup tone of your connected guitar.

  

/off.
tor will be enabled 

   

e:

 

 Transforms the sound of a humbucking 
il pickup.

 

) :

 

 Transforms the sound of a single coil 
ing pickup.

  

 tone” sound.

  

und of pickups wired out of phase.

  

kup type selected by “TYPE.” The result will 
played.

OTE: If you want to tune without producing sound, click the MUTE 
button.

Use the LED meter to tune your guitar precisely.
Tune the string so that only the center LED is lit. The illumination in 
the LED meter will move to the right of center if the pitch is sharp, or 
to the left if the pitch is flat.
erforming with your guitar

uning your guitar — TUNER
In the effect routing area, click TUNER to select it.

The tuner will appear in the effect control panel.

If necessary, click the CALIB buttons (ππππ/††††) to specify the calibration.
The calibration is the reference frequency used for tuning (expressed 
as the frequency of the middle A note of a piano, A4). You can adjust 
this in a range of 410–480 Hz. By default, this is 440 Hz.

Play a single note on your guitar, and tune the pitch approximately, so 
that the desired note name appears in the display.

Changing the charac
PICKUP SELECTOR
The pickup selector simulat
ups, allowing you to modify

ON/OFF
Turns the pickup selector on
If this is on, the pickup selec
for all guitar programs.

TYPE
Selects the type of pickup.
Hum (Humbucker) > Singl
pickup to that of a single co
Single > Hum (Humbucker
pickup to that of a humbuck
Half Tone: Produces a “half
Phase Out: Produces the so

TONE
Adjusts the sound of the pic
depend on the pickup type.

CALIB button

LED meter
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me — METRONOME
etronome on/off, and specify its tempo and time 

/off.

s volume

’s note value.

’s time signature.

e metronome.
nome click sound.
’s side stick sound.
Rec buttons
When recording, these buttons specify whether the guitar, mic, and music 
player tracks will be recorded. If a button is off (unlit), that track will not 
be recorded (☞“Recording” on page 26).

Guitar/Mic/Music buttons
These turn the guitar, mic, and music player tracks on/off. If a button is 
off (unlit), that track will not be output.
Adjusting the volume and panning of the entire 
program — MIXER
Here you can adjust the volume of the guitar, mic, and music player 
tracks.

Faders (-infinity – +6 dB)
These faders adjust the output level of the guitar, 
mic, and music player. The default setting is 0 dB.

Peak indicators
Indicate the peak level of the guitar, mic, and 
music player volumes.

PAN
Adjusts the panning of the guitar output.

ECHO
Adjusts the echo for the mic output.

LOUDNESS
Boosts the low range and high range of the song being played by the 
music player.

Depending on the song that’s playing, raising the LOUDNESS knob 
may cause distortion. If so, lower the fader.

Using the metrono
Here you can turn the m
signature.

ON/OFF
Turns the metronome on

TEMPO
Adjusts the tempo.

VOLUME
Adjusts the metronome’

RHYTHM
Specifies the metronome

BEATS
Specifies the metronome

SOUND
Specifies the sound of th
Click: The typical metro
Side Stick: A snare drum
Cowbell: Cowbell.
Hi-Hat: Hi-hat.



JamVOX owner’s manual

12

C
1

2

3

4

onnecting a mic
Connect a dynamic mic to the JamVOX monitor ’s MIC IN jack.

Only dynamic mics can be connected. You can’t connect mics that 
require a power supply, such as a condenser mic.

Make sure that the mixer’s mic track is on (lit blue) and that the mic 
fader is at the 0 dB position.
The middle fader of the mixer is the mic fader.

Use the JamVOX monitor’s MIC INPUT LEVEL knob to adjust the 
input level of the mic.
While you vocalize into your mic, adjust the level as high as possible 
without allowing the mixer’s peak indicator to light.

Use the faders of the mixer to adjust the volume balance of the guitar, 
song, and mic.
Play your guitar or the music player while vocalizing into the mic, 
and make adjustments as desired.
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nds
d by editing a preset program
our sound by editing an existing program, choose a 
o the sound you want, and then edit the amp and 
reate the desired sound. For example, you might 
runch sound, and raise the gain to create a contem-
at’s louder with a more emphasized mid-range.

xit the JamVOX application during your editing, the 
f the program can be recovered the next time you 
pplication (☞“Startup” on page 35).

 sound
a sound from scratch.

gram from the popup menu or from the library.

et control panel located below the effect routing, use 
n amp model.

d amp model name to see a catalog, or use the ππππ/
†††† buttons to select an amp model. The design of the panel will 

g on the amp model you select.
le-click the amp displayed in the effect routing, or 
inet name and choose an amp model and recom-

rom the catalog that appears.
 types of amp model, refer to “JamVOX Effect 

 to use an amp model, turn the BYPASS switch 
 of the amp model name) off so that the indicator is 

p/Cabinet
Ho
You
pre
gra
from

Ho
The
rou
Rou
noi
item
cha
the
In J
pan

Ef

Am
 co

Ef
change dependin
You can also doub
click the amp/cab
mended cabinet f
For details on the
guide” (PDF).
If you don’t want
(located at the left
dark.

fect control
 panel

ntrol panel
Creating your own sou
w to create your own sounds

 can create a sound in either of two ways. You can choose an existing 
set program that’s close to the sound you want, and then edit the pro-
m as necessary. Or, you can create your sound “from scratch,” starting 

 a “blank” state.

w a guitar program is structured
 effect section of the JamVOX software is broadly divided into effect 
ting, amp/cabinet control panel, and effect control panel
ting includes the tuner, pedal effect 1, pedal effect 2, amp/cabinet, 

se reduction, modulation effect, delay effect, and reverb effect. For 
s other than the amp/cabinet, you can drag and drop them to freely 

nge the way in which they’re connected, to remove them from or add 
m into the routing line.
amVOX you can use this effect routing area, amp/cabinet control 
el, and effect control panel to edit the sound of the amp and effects.

Creating a soun
If you want to create y
program that’s close t
effect parameters to c
start with a modern c
porary lead sound th

HINT: Even if you e
edited state o
start up the a

Creating a new
Here’s how to create 

1 Choose Initial Pro

2 In the amp/cabin
“AMP” to select a

Click the displaye

fect routing
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3

4

5

6

control panel.

l, use “EFFECT MODEL” to select an effect 

odel name and choose from the catalog that 
 buttons to select an effect. The panel design 

t model that’s selected.
atalog by double-clicking an effect that’s 
ng, or by clicking the effect name.
of effect model, refer to “JamVOX Effect 

 a selected effect model, turn its BYPASS 
t of the effect model name) off so that the 
 and drop it in the effect routing area to 

ng line.

 the effect control panel to edit the effect 

ble parameters, refer to “JamVOX Effect 

 models as described in steps 6 and 7.

 model or effect model settings, the JamVOX 
 clip. If this occurs, adjust the output level of 
distortion-type effect model.

e volume, such as when there are volume dis-
uitar programs, adjust the PROG LEVEL 
per right of the effect routing.

tton or Save As button to save the guitar pro-
ar program” on page 16).
10 If you need to adjust th
crepancies with other g
that’s located at the up

11 Click the utility Save bu
gram (☞“Saving a guit
In the amp/cabinet control panel, use “CABINET” to select a cabinet 
model.
Click the displayed cabinet model name and choose from the catalog, 
or use the ππππ/†††† buttons to select a cabinet model.
For details on the types of cabinet model, refer to “JamVOX Effect 
guide” (PDF).
If you don’t want to use a cabinet model, turn the BYPASS switch 
(located at the left of the cabinet model name) off so that the indicator 
is dark.

Use the control knobs in the amp/cabinet control panel to adjust the 
sound of the amp.
For details on the amp parameters, refer to “JamVOX Effect guide” 
(PDF).

Drag and drop effects in the effect routing section to add them to the 
routing line. You can also drag and drop effects to change the order in 
which they are connected.

Click an effect that you want to edit.
The panel of the selected effect will appear below the amp/cabinet 

7 In the effect control pane
model.

Click a displayed effect m
appears, or use the ππππ/††††

will depend on the effec
You can also access the c
shown in the effect routi
For details on the types 
guide” (PDF).
If you don’t want to use
switch (located at the lef
indicator is dark, or drag
remove it from the routi

8 Use the control knobs of
parameters.
For details on the availa
guide” (PDF).

9 You can edit other effect

Depending on the amp
monitor’s output may
the amp model or the 
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g the current settings — Snapshot
ts you temporarily save the current settings of 

m when desired. In the process of creating a gui-
is function to save interim results that you can 

e editing.

ram.

he utility Snapshot button.
 white, and the settings of the guitar program at 
ked the Snapshot button will be temporarily 

t the right of the Snapshot button, and a popup 

the guitar program name, and the date and time 
d the snapshot.

4 From the menu, choose a guitar program name/date/time.
will change to the settings that you saved at the 
e.

ettings in the Option menu allow you to specify 
 which the saved snapshot data will be saved, or 
apshot Function” on page 36).
The guitar program 
selected date and tim

HINT: The Preference s
the duration for
to erase it (☞“Sn
Comparing an edited program with the 
original program — Compare function
Here’s how to compare the sound you’re editing with the original 
unedited sound.

1 Select an existing program, and edit it.
When you edit, the program name will change to a slanted typeface.

2 During your editing, click the utility Compare button.
The guitar program will return to the unedited settings. The program 
name will also return from the slanted typeface to the original type-
face. Each time you click the Compare button, you will alternate 
between the edited sound and the original sound.

Temporarily savin
The Snapshot function le
the edited guitar progra
tar sound, you can use th
compare as you continu

1 Edit an existing prog

2 While editing, click t
The screen will light
the moment you clic
saved.

3 Click the†††† located a
menu will appear.
This menu contains 
at which you capture
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rograms to JamVOX-Online
tar programs in JamVOX and upload them to 
ad and use guitar programs that were created 
s.
 programs.

X-Online, your computer must be connected 

 as a user in order to upload guitar programs.

 list that includes the guitar program you 

 be shown in the main list.

ogram (Mac: Control-click), and choose 
hat appears.
itar program will be displayed.

 as a user, proceed with registration as 
x that appears.

if necessary, and then click OK. The guitar 
d. If you decide to cancel, click Cancel.

r program you’re currently playing, click the 
n that’s located at the right of the program 
aving a guitar program
ere’s how to save a guitar program you’ve edited.

If you switch to a different program without saving the one you’ve 
edited, your changes to the edited program will be lost.

ave (overwrite)
 you click the utility Save button, the current settings will be saved by 
verwriting them onto the program that is saved in the library.

ave As
his will save the program to the library as a new program, separately 
om the currently-edited program.

Click the utility Save As button.
A dialog box will appear, allowing you to enter information about the 
program.

Enter the information as necessary.

Click the OK button.
The edited settings will be saved as a new program, and added to the 
library.

Uploading guitar p
You can create your own gui
JamVOX-Online, or downlo
and uploaded by other user
Here’s how to upload guitar

In order to use JamVO
to the Internet.

You’ll need to register

1 Click to select the source
want to upload.
The guitar program will

2 Right-click the guitar pr
Upload from the menu t
Information about the gu
If you haven’t registered
directed by the dialog bo

3 Note the content, edit it 
program will be uploade

NOTE: To upload the guita
utility Upload butto
name.
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ms,” the selected data will appear in the main list.

e
audition, and download guitar programs and GXT 
een uploaded to JamVOX-Online. If you’ve clicked 
on, popular guitar programs or GXT programs will 
Downloading guitar programs from JamVOX-
ng GXT programs from JamVOX-Online”)

n favorite songs or guitar programs. You can click 
d a new source list. By default, there will be source 
rograms,” “GXT Programs,” “Rhythm Patterns,” 

d “My Downloads.”

f the library source lists “Music,” “Guitar pro-
grams” to select it, the main list will show the data 
 by that source list.
arious information about the data. You can edit this 
ormation dialog box that appears when you select 
ile menu or right-click (Mac: Ctrl-clicking) it and 
In t
VO

Ite

Lib
Her
suc
rate

Thi
in J
gra

J

Music
This manages all of the songs you’ve loaded into JamVOX.

Guitar programs
This manages all of JamVOX’s guitar programs; the preset guitar 
programs as well as the guitar programs you’ve created.

GXT programs
This manages all of JamVOX’s GXT programs; the GXT program 
templates as well as the GXT programs you’ve created.
Library / List
he library you can edit and manage songs you’ve loaded into Jam-
X, guitar programs, GXT program data, and program information.

ms in the screen

rary
e you can manage all data used by JamVOX. The various types of data 
h as songs, guitar programs, and GXT programs are managed in sepa-
 “source lists.”

 Master library
s manages all of the songs, guitar programs, and GXT programs saved 
amVOX. When you click “Music,” “Guitar programs,” or “GXT pro-

 JamVOX-Onlin
Here you can search, 
programs that have b
here to make a selecti
appear in the main. (“
Online”, “Downloadi

 My Libraries
This manages your ow
the  button to ad
lists such as “Guitar P
“My Recordings,” an

Main list
When you click one o
grams,” or “GXT pro
that’s being managed
The main list shows v
information in the inf
“Get Info” from the F
choosing “Get Info.”

Library

Master Library

Source List

Main List+ button

amVOX-Online
My Libraries
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 your computer.

ill display a dialog box asking you to choose 
ll start up iTunes. We will not use these in this 
se the dialog box or iTunes.

ose “Import CD...”.
ox will appear. This dialog box will show the 
r the songs on the CD.

st names will be shown only for this bundled 
 another CD, you’ll need to enter the song title 
 JamVOX software after importing.

ou don’t want to import, click them to clear 

ge the audio format in which the tracks will 
e the setting in the Preferences dialog box.

dialog box, click the “Import” button.
 been completed.

 won’t be able to import the CD if you’re 
puter whose CD/DVD drive is an external 
se other software that is able to import a CD 
, and then add the resulting audio files into 

.

WAV (.wav/.wave)
AIFF (.aif/.aiff)
WMA (.wma): Supported only on Windows.
AAC (m4a): Supported only on Mac.
dding data
 order to play back audio data using JamVOX’s music player, you’ll 

eed to add the song to the JamVOX library.

dding a song from the menu
From the File menu, choose “Add to library...”.
A dialog box will appear.

Select the song that you want to add to the library, and click the 
[Open] button. Alternatively, double-click the file name of the song 
that you want to add.
The song will be added to the library and shown in the main list for 
Music.

dding a song by dragging and dropping
Drag and drop a song file from your computer directly into the main 
list.
Even if the items shown in the main list are not songs, the songs you 
dragged and dropped will be added to the Music library.

porting a song from a CD
ngs from a music CD inserted in your computer can be converted to 

ata and added to the library.
he music player can convert the song into the following types of audio 
ata.

1 Insert the music CD into

Normally, Windows w
an action, and Mac wi
example, so simply clo

2 From the File menu, cho
The Import CD dialog b
titles and artist names fo

The song titles and arti
CD. If you’re importing
and artist name into the

3  If there are any tracks y
their check boxes.

NOTE: If you want to chan
be imported, chang

4 In the lower right of the 
Wait until importing has

The JamVOX software
using a Windows com
drive. You’ll need to u
from an external drive
the JamVOX software
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ge of libraries and lists

 and search for guitar programs, GXT programs, 
n computer or on JamVOX-Online.

 that you want to search.

ARCH field, and enter the characters you want to 

ter will narrow the search and display the results in 

that song or program to the library.

e
ams that other users uploaded to JamVOX-Online.

ick JamVOX-Online to select it.
Popular programs will be shown in the main list.

rogram you want, enter the song title or artist 
 field and press your computer’s Return key.

ill appear in the main list. If you don’t get the 
ntering different items in the SEARCH field.

 programs suitable for a favorite song, click the 
s button  located at the right of the “Name” 
in list. The “Song title” and “Artist” will auto-

ered in the SEARCH field, allowing you to 
 desired program.
2 If you don’t see the p
name in the SEARCH
The search results w
desired results, try e

NOTE:  To quickly find
magnifying glas
shown in the ma
matically be ent
quickly find the
Importing songs from the iTunes library
1 From the File menu, choose “Import iTunes library.”

All songs that have been imported into iTunes will be added to the 
JamVOX library.

NOTE: Depending on the number of songs being imported, this may 
take some time.

Songs protected by DRM (Digital Rights Management) cannot be 
imported.

Importing ToneLab LE programs
Program data created in VOX ToneLab LE can be added to the guitar pro-
grams of the JamVOX library.

NOTE: The ToneLab LE program data must already be saved on your 
computer. For details, refer to the ToneLab LE Editor Help.

1 From ToneLab LE Editor’s File menu, use “Export...” or “Save As...” 
to save the effect program data (.tllp) on your computer.

2 From the File menu, choose “Import ToneLab LE programs...”
A dialog box will appear, allowing you to select the file to import.

3 Select a file, and click the [Open] button.
The ToneLab LE programs will be added to the Guitar Program 
library.

Taking advanta

Searching for data
You can enter a keyword
or songs within your ow

1 Select the source list

2 Click to select the SE
find.
Each character you en
the main list.

3 Double-click to add 

Using JamVOX-Onlin
You can search for progr

1 In the library area, cl
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Info.”
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4

  

5

  

s shown in the main list

 

 of information that will be shown in the list. 
ach library.

  

itle area of the main list. (Mac: Control-click)
ill appear, showing the items that can be 

 

2

 

Select each item that you want to see, so that a check mark is shown 

a check mark will be shown in the list.
ark, that item will not be shown in the list.
Click the Info tab.
The song information will be displayed.

Edit the song information.

When you’ve finished editing, click the OK button to close the dialog 
box.

by it.
Items for which there is 
If you remove a check m
diting information

diting information in the main list
ere’s how to edit items of the main list within the list itself.

In the main list, click the row that contains the item you want to edit.

Click the item that you want to edit.
The item will become editable.

Edit the item and press the Return key.

diting information in a dialog box
ou can edit the information for songs, guitar programs, or GXT pro-
rams saved in JamVOX. As an example, here’s how to edit the informa-
on for a song.

Select the Music library, and then select one of the songs in the main 
list.

Right-click the song, and from the menu that appears, choose “Get 
Info.”(Mac: Control-click)

The data information dialog box will appear.
You can also access this dialog box by choose the File menu item “Get 

Choosing the column
You can choose the columns
Your choices are saved for e

1 Right-click the column t
The display option list w
shown.
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In this way, songs in the library that have the same genre or guitarist 

etc. can be brought together in the list.

NOTE: If the item by which you want to sort is not shown, right-click the 
column title to access the option list, and check the item for the 
column that you want to see. (☞“Choosing the columns shown in 
the main list” on page 20)
Sorting the data in the list
You can sort the items in the main list. The sorting criteria are saved for 
each list.

1 Click a column title in the main list.
The data in the list will be sorted by the column you clicked. For 
example if you clicked “Name” in the Music library, the list will be 
sorted by name.

2 Click the triangle symbol shown at the right of the column title.
The sorting order will be reversed.

l



22

g a song you’ve added to the 

ibrary” - “Music.”
the songs that have been added to the library.

the song that you want to play.

 button, or double-click the name of a 
 list.
lay. During playback, “ ” is shown at the 

progress bar that indicates the playback posi-
, and the playback time.
ack by clicking the PLAY/PAUSE button.

rwarding the song
ng playback will take you to the beginning of 

the currently-playing song. If you click this button near the beginning of 
 beginning of the preceding song.
ng playback will take you to the beginning of 

he song playback location by clicking the bar 
display.
JamVOX 
saved on 
The musi
• WAV (
• AIFF (
• MP3 (
• WMA
• AAC (

Son
pla

The musi
ticing or f
• Loop p
• Adjus
• GXT f

song t
• Auto C

within
• Record
the song, you’ll return to the
Clicking the  button duri
the next song.

HINT: You can also move t
that’s shown in the 
Music player
contains a music player. You can use it to play audio data that’s 
your computer, or to record your guitar or other performances.
c player can play back the following types of audio data.
.wav/.wave)
.aif/.aiff)
.mp3)
 (.wma): Supported only in Windows.
m4a): Supported if QuickTime 7 is installed.

gs protected by DRM (Digital Rights Management) cannot be 
yed.

c player provides the following functions that are ideal for prac-
or learning songs by ear.
layback within a song.

table playback speed and adjustable pitch.
unction that lets you cancel or extract the guitar part from the 
hat’s playing.

hange function that lets you assign a marker to a location 
 a song, causing the effect to switch automatically.
 songs and performance.

Playing a song

Selecting and playin
library
1 In the source list, click “L

The main list will show 

2 In the list, click to select 

3 Click the PLAY/PAUSE 
song shown in the main
The selected song will p
far left of the main list.
The display will show a 
tion and the loop region
You can pause the playb

Rewinding or fast-fo
Clicking the  button duri
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Use the Tempo knob to adjust the tempo.

or more songs repeatedly
ack one or more songs repeatedly.

e song
he repeat button  twice to make it indicate 

ck all songs in the list
he repeat button  once to make it indicate 

region in a song
ant loop playback to begin, click the  button 
 of the display. At the point where you want the loop 
ton. The region you specified will play as a loop.
ted by  and  markers and by a blue bar. You 
change the loop region.

egion can be specified for each song.

op start point, the loop button  below the 
 the repeat button will indicate  .

If you click the loop button to make it go dark, loop playback will turn off. 
s maintained for each song even if loop playback 

d Show/Hide Hints in Preferences–Appearance, 
n will be shown when you move the mouse over 
Moving the knob will turn on the Tempo adjustment function 
(the Tempo button will light). You can adjust the tempo in a 
range of -50%–+150%.
To return to the original tempo, click the Tempo button to 
make it go dark.

The loop region setting i
is turned off.

HINT: If you’ve selecte
loop informatio
the marker.
Adjusting the song’s volume
Use the fader located in the right of the Mixer section to adjust the volume 
of the currently-playing song.

HINT: In the Mixer section you can adjust the volume balance of the 
guitar, mic, and song playback.

You can adjust the LOUDNESS knob to boost the low and high frequency 
ranges of the song playback.

Depending on the song that’s playing, raising the LOUDNESS knob 
may cause distortion. If so, lower the fader.

Adjusting the song’s pitch
JamVOX lets you adjust the pitch of the currently-playing 
song without affecting its tempo.
Use the Pitch knob to adjust the pitch.
Moving the knob will turn on the Pitch function (the Pitch 
button will light).
You can adjust the pitch in a range of -500 cents (-5 semi-
tones)– +500 semitones (+5 semitones).
To return to the original pitch, click the Pitch button to make it go dark.

Adjusting the song’s tempo
JamVOX lets you adjust the tempo of the currently-playing 
song without affecting its pitch.

Playing back one 
JamVOX lets you play b

To repeatedly play on
Below the library, click t

 .

To repeatedly play ba
Below the library, click t

 .

Playing a looped 
At the point where you w
located in the upper right
to end, click the  but
The loop region is indica
can drag the markers to 

NOTE: Only one loop r

When you specify the lo
source list will light, and
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ow/Hide Hints in Preferences – Appearance, 
rmation will be shown when you move the 
ker.
the Auto Change function will turn on, and 

 located below the library will light. Click-
ill turn off the Auto Change function.

 change data by dragging and dropping a gui-
 from the main list onto an empty marker or 

ns auto change data. 
ragging it.

c: Control-click) a marker to access a shortcut 
xecute operations such as Selecting, Moving, 
: Empty marker (a marker that contains no auto change data)

: Guitar program marker

: GXT program marker

: Guitar program and GXT program marker

GXT program markerGuitar program and GXT program marker Guitar program marker
witching guitar programs while the song plays — 
uto Change function

he Auto Change function automatically switches guitar programs or 
XT programs while the song plays.

t the desired locations in a song, you can assign Auto Change markers 
ntaining your favorite guitar programs or GXT programs so that these 

rograms will automatically be selected when the song playback reaches 
ose points. You can assign auto change data for a guitar program and a 
XT program in each marker, and up to twenty markers can be assigned 
 a song. (This does not include the A-B markers of the loop region.)

ssigning a marker
 the main list, click the auto change  button to assign a gui-
r program or GXT program marker at the current playback location. 
hen you assign a marker, a marker icon will appear below the progress 

ar at the location you clicked.
y clicking the  button located at the lower left of the display, you can 

d an empty marker (a marker that contains no auto change data) at the 
rrent playback location. After assigning an empty marker, you can add 

ata later.

HINT: If you’ve selected Sh
the auto change info
mouse over the mar

When you assign a marker, 
the Auto Change button 
ing this to make it go dark w

Editing a marker
You can add or rewrite auto
tar program or GXT program
a marker that already contai
You can move a marker by d
You can also right-click (Ma
menu from which you can e
or Deleting the marker.

guitar program 1 guitar program 2

Intro part A

guitar program 3

part B

guitar program 4

guitar solo

…
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Using the event list to edit markers in detail
An event list will appear when you click the  button located in the 
lower right of the display. Here you can make detailed edits to the auto 
change data of the markers, and to the loop region settings.

The event list shows auto change data and loop region settings.
You can add or rewrite auto change data by dragging and dropping a gui-
tar program or GXT program from the main list onto a line that shows 
marker information.
You can also click time data to select it, and then enter a time value 
directly from your computer keyboard.
By clicking the preview [Preview] button, you can start playback from 
slightly ahead of the specified point in order to verify the settings.
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lay the song. When you reach the point at 
ecording, click the  button. Alternatively, 
ove to the location at which you want to start 

utton to enter record-standby mode (the mid-
l blink), and then click the  button to begin 

ay your guitar along with the song playback.
 button indication will change to .

erforming, click the  button to stop record-

utomatically be added to the library, and will 
ter’s My Recordings folder.
orded data, you can choose WAV, AIFF, WMA 
 (Mac only). Use the Preference settings to 
When you’ve finished adjusting the recording level, click the  but-
ton to stop.

Click the  button to return to the beginning of the song.
ecording
mVOX lets you record your own performance. You can also record your 

wn performance along with a song played by the music player.
ou can try recording your own performance along with one of the 
araoke songs on the included CD, or along with a song whose guitar 
ack you’ve cancelled using the GXT function.
 this example, we’ll record your guitar performance along the song 

layback.

In the Mixer section, make sure that you’ve made the following set-
tings.
Make sure that the Rec button at left (Guitar) and the Rec button at 
right (Music) are lit. If not, click to make them light.
Make sure that the Guitar button and the Music button located below 
the Rec buttons are lit. If not, click to make them light.

OTE: The Rec button and Mic button in the center are for the mic. In 
this example, we don’t care about the state of these buttons.

Click the  button located in the upper left of the display to show 
the recording level meter.

Adjust the recording level. Click the  button to play back the song, 
and perform on your guitar.
While you watch the level meter, use the mixer’s faders to adjust the 
level of the guitar and the song. Adjust the level so that the loudest 
volumes reach the “0” position of the meter.

6 Click the  button to p
which you want to start r
click the progress bar to m
recording, click the  b
dle of the  button wil
recording.
Recording will begin. Pl
During recording, the 

7 When you’ve finished p
ing.
The recorded data will a
be saved in your compu
As the format for the rec
(Windows only), or AAC
select the format.
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nction

nt to cancel the guitar part.

nt to extract/emphasize the guitar part.

raph of the area that will be cancelled or extracted/
y area is the area that will be cancelled. By using the 
ph, you can adjust the DIRECTION, WIDTH (the ❒ 

object), and GAIN.

EQ. BANDS sliders
uency band of the guitar part that you want to can-
size. Use the LO slider at left to specify the lowest 
t sound, and use the HI slider at right to specify the 
GX
tha
exis
Wit
par
you
you

GX

Mu

GX
Tur

Edi
Sho
Edi
aut
disa
t button
ws/hides the GXT edit panel. If the GXT button and 
t button are both off, turning the GXT button on will 
omatically turn the Edit button on as well. (You can 
ble this in the Preference settings.)

TARGET GUITAR FR
These specify the freq
cel or extract/empha
frequency of the targe
highest frequency.
GXT (Guitar XTracktion) fu
T: Guitar XTracktion is revolutionary technology developed by Korg 
t lets you cancel or extract/emphasize a desired guitar part from an 
ting song.
h simple operations you can cancel or extract/emphasize the guitar 
t from your favorite songs so that you can practice or play along on 
r guitar. This section explains the various functions of GXT so that 
’ll be able to take full advantage of it.

GXT works by determining the sound’s “stereo position” (panning) 
and “frequency band.” This means that it won’t be effective on 
monaural songs. Furthermore, other sounds in the same stereo 
position and frequency band will be cancelled as well. Also, the 
effect may be difficult to notice on some songs depending on how 
the guitar part has been mixed.

T parameters

sic player

T button
ns the GXT: Guitar XTracktion effect on/off.

GXT edit panel

Reduce button
Turn this on if you wa

Extract button
Turn this on if you wa

Graph
This is a conceptual g
emphasized. The gra
mouse to drag the gra
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art
method for using GXT to cancel a guitar part.

listen to determine where in the song (left 
th sides) the guitar part you want to cancel is 

ermine if you use headphones.

d where the guitar part to be canceled is 
utton.
 on, and the GXT edit panel will appear.

 the left of the GXT edit panel, double-click a 
e positioning of the guitar part you want to 

late will be applied to the GXT edit panel and 

ates are provided.
eduction:
re panned to the center, this template will 

) Reduction:
pread very far to the left or right, try using 
l have less effect on sounds other than the 

03 Solo (Left) Reduction:
eling a guitar solo that’s panned toward the 

on:
eling a guitar solo that’s panned toward the 

tion:
eling a backing guitar that’s panned toward 
This template is for canc
left.
04 Solo (Right) Reducti
This template is for canc
right.
05 Backing (Left) Reduc
This template is for canc
the left.
REA buttons
: Select this if you want to cancel or extract/emphasize a guitar 

part that’s panned to the left side of the song.
: Select this if you want to cancel or extract/emphasize a guitar 

part that’s panned to the center of the song.
: Select this if you want to cancel or extract/emphasize a guitar 

part that’s panned to the left and right sides of the song.
: Select this if you want to cancel or extract/emphasize a guitar 

part that’s panned to the right side of the song.

IRECTION slider
his adjusts the panning of the area in which you want to cancel or 
tract/emphasize a guitar part.

IDTH slider
his adjusts the width of the area in which you want to cancel or extract/

phasize a guitar part.

AIN slider
his adjusts the gain of the area in which you want to cancel or extract/

phasize a guitar part.

INT: It’s convenient to use the arrow keys (↑, ↓, ←, →) of your com-
puter to make detailed adjustments to the graph or sliders.

Making GXT settin

Canceling a guitar p
Here we’ll explain the basic 

1 Play back the song, and 
side, center, right side, bo
panned.
This will be easier to det

2 When you’ve determine
located, press the GXT b
The GXT effect will turn

3 From the template list in
template that matches th
cancel.
The settings of the temp
to the playback audio.
The following ten templ
01 Solo (Center-Wide) R
Since most guitar solos a
probably work well.
02 Solo (Center-Narrow
If the guitar solo is not s
this template, which wil
guitar.
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4 You should be able to hear the result of canceling the guitar part. If 

Extract button, and while auditioning the 
ed guitar part, lower the frequency until you no 
d of the bass part. Then press the Reduce button, 
e frequency to obtain the appropriate cancella-
s of the guitar part.
xtract button, and while auditioning the 

ed guitar part, lower the frequency until you hear 
f the hi-hat and snare attacks. Then press the 
gradually raise the frequency so that the guitar 

uch as possible. Repeat this process to make the 
ents.

 the GXT parameters, minimizing the effect on 
s is an important part of obtaining the most natu-
ncellation.

e set the WIDTH fairly wide, set the HI slider as 
at the hi-hat is excluded from the cancellation 

 set the WIDTH quite narrow, hi-hat sound will 
rey area, so you’ll be able to raise the HI slider.

sizing the guitar part
ttings described above, you can press the Extract 
size the corresponding guitar part.
se by ear, and would like to obtain the best possi-

ble extraction/emphasis effect, adjust TARGET GUITAR FREQ. BANDS, 
nd GAIN as described in “Canceling a guitar 

g or practicing a phrase, it’s especially useful to 
nction with the Tempo Change function that lets 
the tempo without affecting the pitch.
you want to obtain the best possible cancellation effect, adjust the 
TARGET GUITAR FREQ. BANDS, DIRECTION, WIDTH, and GAIN 
as appropriate for the song.
First, use the graph and sliders to find the most effective settings for 
DIRECTION, WIDTH, and GAIN while you listen to the cancellation 
of the guitar part.
Next, use the TARGET GUITAR FREQ. BANDS sliders to specify the 
frequency range of the guitar part.
It’s best to adjust the TARGET GUITAR FREQ. BANDS settings in the 
following ways.

DIRECTION, WIDTH, a
part.”

HINT: If you’re copyin
use this in conju
you slow down 
06 Backing (Left-Hard) Reduction:
This template will be effective if the backing guitar that’s panned 
toward the left has a heavy sound that includes low frequencies and 
high overtones.
07 Backing (Right) Reduction:
This template is for canceling a backing guitar that’s panned toward 
the right.
08 Backing (Right-Hard) Reduction:
This template will be effective if the backing guitar that’s panned 
toward the right has a heavy sound that includes low frequencies and 
high overtones.
09 Backing (Left & Right) Reduction:
This template is for canceling a backing guitar that’s panned to both 
left and right sides.

NOTE: Typically, the sound of the backing guitar is also spread through 
the center of the stereo field. Since the sound in the center will 
remain even if you cancel the sound at the left and right sides, the 
effect will probably not be very dramatic.

10 Vocal (Center) Reduction:
In general, a vocal has a broader frequency range than the sound of a 
guitar, and will be spread to left and right. If you want to cancel the 
sound of a vocal, start with this template and then adjust the parame-
ters.

LO slider: Press the 
extracted/emphasiz
longer hear the soun
and raise or lower th
tion for the low note
HI slider: Press the E
extracted/emphasiz
as little as possible o
Reduce button, and 
part is cancelled as m
appropriate adjustm

NOTE: When adjusting
the drum sound
ral-sounding ca

For example if you’v
low as possible so th
effect.
Conversely if you’ve
remain outside the g

Extracting/empha
After you’ve made the se
button to extract/empha
If you’re learning a phra
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 programs from 

T programs in JamVOX and upload them to 
ad and use GXT programs that were created 
s.
T programs.

X-Online, your computer must be connected 

 as a user in order to audition or download 
 haven’t registered as a user, you’ll only be 

OX-Online to select it.
popular guitar programs and GXT programs.

 to use is not shown, enter a song title or artist 
ld and press your computer’s Return key.
own in the main list. If you don’t get the 
nging the terms you enter in the SEARCH 

 programs suitable for a favorite song, click 
s button  located at the right of the 
e main list. The “Song title” and “Artist” will 

tered in the SEARCH field, allowing you to 
ired GXT program.

ayed program by double-clicking it.
 as a user, proceed with registration as 
x that appears.

click the download button that’s shown in the 
m will be saved in “My Downloads.”
3 You can audition a displ
If you haven’t registered
directed by the dialog bo

4 If you like the program, 
main list, and the progra
aving a GXT program
ere’s how to save a GXT program you’ve edited.

If you switch to a different program without saving the one you’ve 
edited, your changes to the edited program will be lost.

ave (overwrite)
 you click the Save button in the GXT edit panel, the current settings 
ill be saved by overwriting them onto the program that is saved in the 

brary.

ave As
his will save the program to the library as a new program, separately 
om the currently-edited program.

Click the Save As button in the GXT edit panel.
A dialog box will appear, allowing you to enter information about the 
program.

Enter the information as necessary.

Click the OK button.
The edited settings will be saved as a new program, and added to the 
library.

Downloading GXT
JamVOX-Online
You can create your own GX
JamVOX-Online, or downlo
and uploaded by other user
Here’s how to download GX

In order to use JamVO
to the Internet.

You’ll need to register
GXT programs. If you
able to search.

1 In the library, click JamV
The main list will show 

2 If the program you want
name in the SEARCH fie
The search results are sh
results you want, try cha
field.

NOTE: To quickly find GXT
the magnifying glas
“Name” shown in th
automatically be en
quickly find the des
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Uploading GXT programs to JamVOX-Online
You can create your own GXT programs in JamVOX and upload them to 
JamVOX-Online, or download and use GXT programs that were created 
and uploaded by other users.
Here’s how to upload GXT programs.

In order to use JamVOX-Online, your computer must be connected 
to the Internet.

You’ll need to register as a user in order to upload GXT programs.

1 Click to select the source list that includes the GXT program you want 
to upload.
The GXT program will be shown in the main list.

2 Right-click the GXT program (Mac: Control-click), and choose Upload 
from the menu that appears.
Information about the GXT program will be displayed.
If you haven’t registered as a user, proceed with registration as 
directed by the dialog box that appears.

3 Note the content, edit it if necessary, and then click OK. The GXT pro-
gram will be uploaded. If you decide to cancel, click Cancel.
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ngs

 the utility Pedal button.

ears when you click EXPRESSION PEDAL 
H SHIFTER - PITCH.

edal’s Max value (the value when the pedal is 
 value (the value when the pedal is fully 

 by dragging in the edit screen.

AX” values will be initialized if you change 
XPRESSION PEDAL.

 close the edit screen.
 settings, click the SAVE button or SAVE As 
 different program or close JamVOX without 

made will be lost.
le described above, a large number of effect 
 each effect model can be freely assigned to 

he effect model of the parameter that is 
on, the “TARGET” parameter will be initial-
F. (However, the Amp “GAIN” or “VR 
INPUT,” and the Reverb “INPUT” are excep-

 WAH as the effect model for pedal effect 1 or 
dal function will automatically be assigned to 

MANUAL (the wah pedal position). In this case, changing the 
er model without performing any other 
eturn the “TARGET,” “MIN,” and “MAX” 

vious state. (However, if the pedal effect 
n is assigned, it will be initialized “OFF” 
 its previous state.)
Using
JamVOX 
JamVOX 

Expres
For each 
trolled by
monitor, 

HINT: A
t
s
b
m
“
R
w
d

Assignin
Here’s ho
As an exa
SHIFTER

1 Choo

2 Press
The F
PEDA
OOT SWITCH and EXPRESSION 
L edit screens will appear.

pedal effect to anoth
operation will also r
settings to their pre
(PEDAL FX) functio
without returning to
Option pedal/switch setti
 a pedal for control
lets you use an optional pedal or foot switch connected to the 
monitor to control a variety of functions.

sion pedal settings
program, you can individually specify the effect that will be con-
 an optional Korg EXP-2 controller connected to the JamVOX 

and how it will be controlled.

ssigning a parameter to the expression pedal and operating it in 
his way is the same as using the pedal instead of the knob to edit the 
ound. When you use SAVE or SAVE As to save the program, it will 
e saved with the sound specified by the pedal position at that 
oment. However, if the expression target is “OFF,” Modulation 

PITCH,” Delay “INPUT” (controls the input level to the delay), or 
everb “INPUT” (controls the input level to the reverb), the pedal 
ill not be editing the parameter of the guitar program. Also, the 
elay effect and reverb effect do not have an “INPUT” parameter.

g a parameter to the expression pedal
w to assign an effect parameter to the expression pedal.
mple, we’ll assign the “PITCH” parameter of the PITCH 
 modulation effect to be controlled by the pedal.

se PITCH SHIFTER as the modulation effect.

3 From the menu that app
“TARGET,” choose PITC

4 Specify the expression p
fully advanced) and Min
returned).
You can check the result

NOTE: The “MIN” and “M
the “TARGET” of E

5 Click the Pedal button to
If you want to save your
button. If you switch to a
saving, the settings you 
In addition to the examp
parameters specified for
the expression pedal.

NOTE: When you change t
assigned to expressi
ized, and will be OF
GAIN,” the Delay “
tions.)

HINT: If you selected VOX
2, the expression pe
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s
OX VFS-2 foot switch connected to the JamVOX 

e variety of parameters.
to assign the program up/down functions to the 
assign the tap tempo function.

ram up/down to the foot switch

l button.
 and EXPRESSION 
will appear.
ll be assigned to Pro-
m Down, respec-

lick “ASSIGN PRO-
 to select it.
e program-down, 
will be program-up.
eration by clicking the foot switches shown in 

gram Up/Down to the foot switch, you won’t be 
 effect parameter function to the foot switch.

ffect’s Tap function to the foot switch
You can assign the modulation effect’s “Speed” parameter or the delay 

r to the foot switch. When you press the foot 
eed of the LFO or the delay time of the delay 
rresponding interval.

sign the “Time” parameter of the delay effect to 
ou continue, turn on the delay effect.

lect the effect model for which you want to 
o the foot switch.
effect’s “Time” paramete
switch repeatedly, the sp
effect will be set to the co
In this example, we’ll as
the foot switch. Before y

1 In the delay effect, se
assign a parameter t
Adjusting the sensitivity of the pedal
If you notice that advancing the expression pedal does not reach the full 
effect or volume even when the Min and Max parameters are set to the 
minimum and maximum settings, or that returning the expression pedal 
does not reach the minimum effect or volume, you will need to perform 
the following adjustment so that expression pedal will be able to reach its 
full range of operation.

NOTE: Set the minimum volume of the connected EXP-2 controller to the 
0 position.

NOTE: When adjusting the sensitivity, you should use your hand to 
operate the pedal. Accurate adjustment may not be possible if 
you use your foot to operate it.

1 Click the Calibration button located below 
EXPRESSION PEDAL. The calibration set-
ting screen will appear.

2 Proceed as directed in the screen.

Foot switch setting
JamVOX lets you use a V
monitor to control a wid
Here we’ll explain how 
foot switch, and how to 

Assigning guitar prog

1 Press the utility Peda
The FOOT SWITCH
PEDAL edit screens 
The two switches wi
gram Up and Progra
tively.

2 In FOOT SWITCH, c
GRAM UP/DOWN”
The left switch will b
and the right switch 
You can verify the op
the edit screen.

NOTE: If you assign Pro
able to assign an

Assigning the delay e



JamVOX owner’s manual

34

2

3

4

5
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6

Press the utility Pedal button.
The FOOT SWITCH and EXPRESSION 
PEDAL edit screens will appear.

In FOOT SWITCH, click “ASSIGN 
BYPASS/EFFECT PARAMETER” to 
select it. 

Click the FOOT SWITCH “TARGET” 
parameter, and choose DELAY TAP 
(TIME) from the menu that appears.

Use “FACTOR” to specify a multiplier for the interval at which you 
tap.
According to the setting of the “FACTOR” parameter, the parameter 
being controlled will be set to 1/6, 1/4, 1/3, 1/2, 2/3, 3/4, 1, 4/3, 3/2, 
2, 3, or 4 times the tapped interval.

OTE: The maximum interval for tapping is ten seconds.

OTE: If “TARGET” is set to anything other than MODULATION TAP 
or DELAY TAP, “FACTOR” will be unavailable. Also, changing 
“TARGET” will initialize “FACTOR” to 1.

Click the Pedal button or the  at the upper right of the edit screen to 
close the edit screen.
If you want to save your settings, click the Save button or Save As but-
ton. If you switch to a different program or close JamVOX without 
saving, the settings you made will be lost.
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 the last-played song
ftware starts, the song that was played last will 
ed.

 the last-selected guitar program
ftware starts, the guitar program that was selected 
ally loaded.

 the last-selected GXT program
ftware starts, the GXT program that was selected 
ally loaded.

s
ethod
t the knobs to operate.
s by dragging them up or down. This is the default 

bs by dragging them in a circular direction.

g an item from the master library
 will appear when you delete a song, guitar pro-

m from a master library list.

ursor over a knob or switch, a simple explanation or 
eter will be shown.
The
the
you
Fro
dia
View
Warn when deletin
A warning dialog box
gram, or GXT progra

Show hints
When you place the c
the value of the param
Preference settings
 Preference settings allow you to specify things like the appearance of 

 JamVOX software or the mode of knob operation as appropriate for 
r system or your taste.
m the Option menu, choose “Preferences…” to access the Preferences 
log box, click the appropriate tab, and make the desired settings.

General
Startup
Automatically load
When the JamVOX so
automatically be load

Automatically load
When the JamVOX so
last will be automatic

Automatically load
When the JamVOX so
last will be automatic

Basic Operation
Knob Operation M
Choose how you wan
Linear: Operate knob
setting.
Circular: Operate kno
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The edit panel will be displayed when you turn the GXT button on or 
w

n
e pitch change function
is off, operating the Pitch knob will automati-
e function.

ion
e tempo change function
 is off, operating the Tempo knob will auto-

 change function.

ich audio will be recorded: WAV, AIFF, WMA 
ac only).

udio will be recorded. This is valid only if 
ows only) or AAC (Mac only) as the audio 

lso used when you load a music CD.

Maximum Recording Time
 for recording.

ound when recording
g while you record, its sound will be 
hen you load a GXT program. Specifies the maximum time

Include the metronome s
If the metronome is soundin
included in the recording.
uitar Programs
napshot Function
elete snapshots when closing
he saved snapshots will be deleted when you close the JamVOX soft-
are.

ngth of time to keep snapshots
his specifies how long snapshots will be kept.

elete Now
 you click this, the currently saved snapshots will be deleted.

OTE: Up to one hundred snapshots can be saved. If you attempt to 
save a snapshot that would exceed this number, the oldest snap-
shot will be deleted.

XT
nk the panning of the GXT program and the guitar output
he pan setting of the guitar output in the mixer will be linked to the 
IRECTION and AREA parameters of the GXT program. This allows you 
 layer the sound of your guitar onto the location of the guitar part that 

ou cancelled using the GXT function.

utomatically show GXT edit panel

Player
Pitch Change Functio
Automatically turn on th
If the pitch change function 
cally turn on the pitch chang

Tempo Change Funct
Automatically turn on th
If the tempo change function
matically turn on the tempo

Recording
Audio Format
Select the data format in wh
(Windows only), or AAC (M

Audio Quality
Select the quality in which a
you’ve selected WMA (Wind
format.

NOTE:  These settings are a
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Hardware
Response
If you feel that there is a lag from when you play your guitar until sound 
is produced, try setting this to “Fast.” If you experience clicks or noise in 
the sound, try setting this to “Slow.”

JamVOX-Online
JamVOX Account
Verify your JamVOX account or log-in to JamVOX-Online.

Log in
Connect to JamVOX-Online. You must have already completed user regis-
tration.

User Registration
Create a JamVOX account and register as a user. Proceed with registration 
in the Web browser that will start up.
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